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1. Versions 

Numéro Commentaire Date 

1.0 Première version du manuel utilisateur 24/05/2016 

1.1 Version du manuel utilisateur 1.1 28/06/2016 

1.2 Modification des instructions d’installation du plugin 22/11/2016 

2.0 Gestion des attributs de thèmes  

Changement de vocabulaire pour les signalements 

Version du manuel utilisateur 2.0 

19/12/2017 

3.0.1 Compatibilité avec QGIS 3 

Changement des couches croquis 

Changement du nom du plugin en IGN_Espace_collaboratif 

Version du manuel utilisateur 3.0 

15/03/2019 

3.0.7 Révision pour déploiement du patch correctif 3.0.7 24/03/2020 

4.0 Ajout du chargement et de l’édition de guichets 

Ajout du chargement des couches Géoportail des groupes 

Correction de divers bugs 

08/01/2021 

4.1 Diffusion sur l’Espace collaboratif 

Suppression du système de clés Géoportail 

01/02/2022 

4.1.1 Adaptation du processus d’installation 11/02/2022 

4.2.0 Mise à jour suite à l’ajout de la contribution directe à la BDUni 

Corrections diverses 

28/06/2023 

4.2.1/4.2.2 Mise à jour des explications sur l’utilisation du proxy 06/07/2023 

4.3.0 Evolution de la fenêtre de choix du groupe 26/08/2025 
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3. Préambule 

3.1 Présentation du service 

L’Espace collaboratif de l’IGN (https://espacecollaboratif.ign.fr) propose deux services principaux : 

• un service de signalement, 

• un service d’hébergement et de contribution à des bases de données, métiers ou IGN. 

Signalement 

Le service de signalement de l’IGN (anciennement remontées d’information partagées RIPart) est un 

service offert par l’Institut national de l’information géographique et forestière (IGN) pour permettre 

à ses partenaires institutionnels de lui transmettre, de façon automatique et normalisée, des 

remarques concernant les données de l’Institut et qui nécessiteraient une correction ou une mise-à-

jour. Ce service peut également être utilisé par les partenaires pour leurs propres besoins (mise à jour 

de données métiers, non destinées à l’IGN). 

Chaque nouveau signalement sur une donnée IGN donne lieu à un traitement hiérarchisé au sein du 

service de l’IGN concerné par la remarque, qui y apportera des réponses officielles. 

Un signalement contient : 

• Une position géographique pour situer le signalement ; 

• Un commentaire rédigé par l'auteur du signalement à l'adresse de l'IGN pour expliquer 
l’objet de son signalement ; 

• Un statut pour situer le signalement dans la chaîne de traitement (reçu dans nos services, en 
cours de traitement, pris en compte…) ; 

• Éventuellement un thème associé pour définir la thématique IGN et/ou la thématique métier 
concernées par le signalement. Il est à noter que les signalements sans thème auront le 
statut ‘en demande de qualification’ tant qu’ils n’auront pas un thème associé. 

• Éventuellement un ou plusieurs attributs liés au thème ; 

• Éventuellement des objets géométriques (ponctuels, linéaires, surfaciques) composant un 
croquis joint à ce signalement. Certains attributs de ce croquis peuvent aussi être joints au 
signalement ; 

• Éventuellement de 1 à 4 fichiers joints de formats divers (pdf, doc, images…). 

Chaque signalement, sauf s’il est lié à un groupe ne partageant pas ses signalements, est accessible 

en consultation à tous les utilisateurs sur l’Espace collaboratif. Il y possède une fiche où tous ces 

éléments sont visibles ainsi que les réponses apportées par l’IGN. 

 

Contribution directe 

L’IGN offre également à ses partenaires la possibilité d’héberger leurs données dans une base de 

données stockée sur l’Espace collaboratif. L’Espace collaboratif propose alors un ensemble d’outils de 

gestion de ces bases ainsi que des outils permettant d’entretenir et de mettre à jour les données 

https://espacecollaboratif.ign.fr/
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qu’elles contiennent. On parle alors de fonctionnalités de contribution directe, accessibles depuis un 

« guichet » de l’Espace collaboratif. 

3.2 Rôle du plugin Espace collaboratif pour QGIS 

Le plugin IGN_Espace_collaboratif est une extension pour le logiciel QGIS, qui permet depuis le SIG 
d'interagir directement avec le service Espace collaboratif (sans passer par le site web 
espacecollaboratif.ign.fr). 

L'utilisateur peut ainsi depuis QGIS : 

• Importer, dans sa carte courante, l'ensemble des signalements d'un lieu donné ; 

• Consulter le contenu des signalements présents sur la carte ; 

• Leur ajouter une réponse (s’il en a la permission) ; 

• Créer de nouveaux signalements qui seront transmis au service concerné. 

• Pour les utilisateurs appartenant à un groupe disposant de permissions d’écriture sur une 
base de données accessible sur l’Espace collaboratif via un guichet : 

o Afficher les couches paramétrées dans la carte de son groupe dans QGIS. 

o Editer les données et les enregistrer dans la base Espace collaboratif correspondante. 

L'intégration du plugin dans le SIG se traduit visuellement par l’ajout d’une barre d'outils 
supplémentaire dédiée aux fonctionnalités du plugin, et par des couches ajoutées à la carte active et 
qui sont destinées à contenir les différents objets provenant de l’Espace collaboratif (ses 
signalements et croquis associés, couches du groupe). 

3.3 Prérequis 

Le plugin IGN_Espace_collaboratif pour QGIS requiert la configuration minimum suivante : 

• Windows 

• Une connexion internet permanente (afin que le plugin puisse communiquer avec le serveur 
de l’Espace collaboratif). 

• Le SIG QGIS, version 3.x . 

L'utilisation du plugin IGN_Espace_collaboratif nécessite de posséder un compte utilisateur sur le site 
espacecollaboratif.ign.fr. L’inscription à un groupe d’utilisateurs est ouverte ;  l’affiliation à un groupe 
d’utilisateurs est en revanche soumise à acceptation par le ou les gestionnaires de ce groupe, et 
permet de déterminer le niveau de permission de l’utilisateur. 

Le plugin IGN_Espace_collaboratif ne fonctionne qu'en association avec un projet QGIS au format 
qgz. C'est à partir de cette carte que le plugin va ajouter ses propres couches qui seront stockées 
parallèlement au fichier qgz dans une base de données SpatiaLite. C'est aussi dans ce même dossier 
que doit se situer le fichier de configuration du plugin espaceco.xml, qui est créé 
automatiquement par le plugin lors de la première utilisation). 

NB : le nom du projet QGIS dans lequel sera utilisé le plugin Espace collaboratif ne doit pas contenir 
de point en dehors de son extension (.qgz). 

https://espacecollaboratif.ign.fr/
https://espacecollaboratif.ign.fr/
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4. Installation et principes de fonctionnement 

4.1 Procédure d'installation 

 
Pour installer le plugin, suivre les étapes suivantes : 

• Ouvrir QGIS et se rendre dans le menu Extension > Installer/Gérer les extensions  
 

 

Figure 1 : le menu de gestion des extensions 

 

• Se rendre dans l’onglet Paramètres et cliquer sur «  Ajouter… » 

• Ajouter le dépôt avec l’URL : https://espacecollaboratif.ign.fr/plugins/plugin-qgis.xml 
 

 

Figure 2 : configuration du dépôt d’extensions 

• Une fois ajouté, s’assurer que les extensions expérimentales sont affichées et que le statut 
du dépôt Espace collaboratif est « connecté » : 
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Figure 3 : Affichage des extensions expérimentales 

  

• IGN_Espace_collaboratif apparait dans l’onglet Nouvelles. Il est possible de l’installer en 
cliquant sur «  Installer l’extension ». Il vous sera alors demandé de vous connecter en 
utilisant le login et le mot de passe de votre compte Espace collaboratif : 

 

Figure 4 : Connexion au compte Espace collaboratif pour installation 

 

• IGN_Espace_collaboratif apparait alors dans la liste des extensions installées. 
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Figure 5: Installation du plugin IGN_Espace_collaboratif 

 

• La barre d’outils IGN_Espace_collaboratif est maintenant présente :  

  

Figure 6 : la barre d'outils du plugin IGN_Espace_collaboratif dans QGIS 

 
Remarque : Si elle n’apparait pas directement, aller dans «  Extensions > Installer/Gérer les 
extensions  », dans l’onglet «  Installées », désélectionner puis re-sélectionner la coche devant 
l’extension «  IGN_Espace_collaboratif »  

4.2 La barre d’outils IGN_Espace_collaboratif 

 

Figure 7 : la barre d'outils du plugin IGN_Espace_collaboratif dans QGIS 

La barre d’outils du plugin IGN_Espace_collaboratif est composée des outils suivants : 

• 1 Se connecter au service. 

• 2 Télécharger les signalements du service et les afficher sur la carte en cours. 

• 3 Visualiser le contenu d’un signalement (commentaire, réponses, document joint, croquis 
associés). 

• 4 Ajouter une nouvelle réponse à un signalement, qui sera envoyée à l’Espace collaboratif. 

• 5 Rédiger un nouveau signalement et l’envoyer à l’Espace collaboratif. 
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• 6 Effacer, dans la carte courante, tous les objets signalements et croquis présents. 

• 7 Sélectionner les croquis associés à un ou plusieurs signalements, ou les signalements 
associés à un ou plusieurs croquis. 

• 8 Charger les couches paramétrées par le groupe de l’utilisateur s’il en a un. 

• 9 Mettre à jour les couches chargées dans QGIS à partir de l’Espace collaboratif. 

• 10 Dérouler le menu d’aide du plugin. 

4.3 Les calques gérés par le plugin 

Lors du premier chargement des signalements, le plugin ajoute dans la carte 6 couches destinées à 
contenir les différents objets IGN_Espace_collaboratif. Ces couches et leurs objets sont enregistrés 
dans une base de données SpatiaLite située dans le même dossier que celui de la carte qgz. 

Attention : Si la carte QGIS contient encore la couche Remarques_Ripart (c’est-à-dire qu’il s’agit 
d’une carte commencée avec la version 1.2 du plugin), il faut supprimer cette couche avant de 
télécharger les signalements. Les 4 couches destinées à contenir les différents objets seront créés à 
nouveau lors du téléchargement. 

Ces couches dédiées se nomment: 

• Signalement : contient les 
signalements de l’Espace 
collaboratif sous forme de 
ponctuels. Les champs de cette 
couche stockent les différents 
attributs associés aux signalements. 

• Croquis_EC_Point : contient les 
croquis de type ponctuel. 

• Croquis_EC_Ligne : contient les 
croquis de type linéaire sous forme 
de polylignes. 

• Croquis_EC_Polygone : contient les 
croquis de type surfacique sous 
forme de polygones simples. 

  

Figure 8 : Couches ajoutées par le plugin dans le projet QGIS 

Ces 4 couches utilisent le même système géographique de coordonnées que celui utilisé par le 
service Espace collaboratif (WGS84, coordonnées géographique en degrés décimaux). Néanmoins, 
l'utilisateur peut utiliser n’importe quel système géographique de coordonnées qui lui convient. Le 
plugin IGN_Espace_collaboratif et le SIG QGIS assurent de façon automatique et transparente le 
changement de projection à la volée et dans les deux sens. 

Le plugin propose une symbologie par défaut pour les signalements en fonction de la valeur du 
champ statut1.  

 

1 Cf. Tableau 3 : Valeurs et signification des statuts 
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Cette symbologie est définie dans les fichiers xx.qml qui se trouvent dans le dossier 
espacecoStyles. Néanmoins, l’utilisateur peut utiliser tout autre symbologie à sa convenance. 

4.4 Configuration du plugin 

Pour son fonctionnement, le plugin stocke tous ses paramètres de configuration dans un fichier de 
type XML dénommé espaceco.xml. Ce dernier se situe dans le même dossier que celui qui contient 
le fichier projet QGIS (qgz). 

Ce fichier étant nécessaire à son fonctionnement, le plugin le génère automatiquement s’il n’existe 
pas déjà. Le paramétrage du plugin se fait via la fenêtre de configuration qui s’ouvre depuis le menu 
[Aide > Configurer le plugin] de la barre d'outils. Les nouveaux paramètres saisis sont 
ensuite automatiquement enregistrés dans ce fichier XML. 

5. Utilisation 

5.1 Connexion au service 

 

Toute interaction entre QGIS et le service nécessite une authentification auprès de ce dernier avec 
un compte utilisateur existant. 

L’action de connexion au service est lancée automatiquement par le plugin avant chaque action en 
cas d'absence de connexion. Elle peut aussi être manuellement lancée par l'utilisateur en cliquant sur 
le bouton Se connecter au service Espace collaboratif. Dans tous les cas, cela 
provoque l'ouverture du formulaire d’authentification. 

Le champ Votre login est pré-rempli par le login utilisé lors de la précédente connexion. 

 

Figure 9 : Formulaire de connexion au service Espace collaboratif 

La fermeture de QGIS interrompt la connexion au service. Il faut donc la rétablir lors de l’utilisation 
suivante du SIG. 
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Note : En cas d’échec de la connexion (message : « la connexion a échoué »), il peut s’agir d’un 
problème d’accès au serveur dû au proxy. Il peut être nécessaire de spécifier un proxy dans la 
configuration du plugin (menu Aide du plugin > Configurer le proxy), cf. §5.12. Attention, la définition 
d’un proxy dans l’interface de QGIS (menu Préférences > Options > Réseau) ne suffit pas. Une autre 
solution consiste à définir des variables d’environnement HTTP_PROXY et HTTPS_PROXY avec les 
valeurs ad-hoc (dépendant de votre établissement) peut régler le problème. 

5.1.1 Cas d’un utilisateur n’appartenant à aucun groupe 

Au clic sur le bouton « Connecter », une fenêtre de confirmation apparaît : 

 

Figure 10 : Fenêtre de confirmation de connexion pour un utilisateur sans groupe 

 

5.1.2 Cas d’un utilisateur appartenant à au moins un groupe 

➢ Au clic sur le bouton « Connecter », une nouvelle fenêtre permettant de paramétrer 
l’utilisation du plugin apparaît : 

 

Figure 11 : Fenêtre de paramétrage du groupe 

• Si l’utilisateur appartient à plusieurs groupes, un menu déroulant lui permet de 
choisir celui dans lequel il souhaite travailler. S’il n’appartient qu’à un seul groupe, 
celui-ci est sélectionné par défaut. 

• L’utilisateur peut choisir sa zone de travail en utilisant le menu déroulant pour 
sélectionner une couche surfacique déjà présente dans la carte ou le bouton 
parcourir pour sélectionner un fichier shape sur l’ordinateur. 
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➢ Après avoir cliqué sur le bouton « Enregistrer », une fenêtre de confirmation de connexion, 
reprenant le paramétrage choisi par l’utilisateur, est affichée : 

 

Figure 12 : Fenêtre de confirmation de connexion pour un utilisateur avec groupe 

5.2 Import des signalements 

 

 

Cliquer sur le bouton Télécharger les signalements pour lancer la procédure de 
téléchargement des signalements depuis l’espace collaboratif IGN. 

La procédure efface préalablement tous les objets des calques spécifiques au fonctionnement du 
plugin IGN_Espace_collaboratif présents sur la carte. Les signalements importés sont mis dans le 
calque Signalement. Lorsqu’ils sont accompagnés de croquis, ces derniers sont importés dans les 
différents calques Croquis_EC. 

Le plugin propose dans le formulaire de configuration, deux options pour filtrer2 l'import des 
signalements selon les besoins de l'utilisateur : 

• Le filtrage spatial : on choisit le calque contenant l’emprise à utiliser pour filtrer les 
signalements à importer. 

• Le filtrage chronologique : l’utilisateur précise une date et seuls les signalements mis à jour 
depuis cette date seront importés. 

L'import de tous les signalements depuis le service Espace collaboratif peut prendre un certain temps 
en fonction du  nombre de signalements et de la qualité de la connexion réseau. C'est pourquoi il est 
judicieux d'utiliser les options de filtrage pour limiter le nombre de signalements à télécharger. 

À l'issue du téléchargement, une fenêtre annonce le succès de l'opération et détaille la répartition 
des signalements importés selon leur statut. 

 

2 Il existe également un filtrage thématique paramétrable sur l’espace collaboratif pour importer des signalements sur des 
thèmes précis. 
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Figure 13 : Fenêtre annonçant la réussite du téléchargement des signalements depuis l’Espace collaboratif 

5.3 Visualisation d’un signalement 

 

Sélectionner un signalement sur la carte, puis cliquer sur le bouton Voir le signalement.  

Une fenêtre avec le message du signalement et les éventuelles réponses s’ouvre : 

  

Figure 14 : Fiche d’un signalement 

5.4 Visualisation des attributs d’un croquis 

Lorsqu’un croquis joint à un signalement a des attributs, ceux-ci peuvent être consultés via la 
fonction « identifier les entités » de QGIS. 
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Figure 15 : Accès aux attributs d’un croquis 

 

 

Figure 16 : Exemple d’attributs liés à un croquis 

 

5.5 Répondre à un signalement 

 

Il est possible de répondre à un ou plusieurs signalements simultanément. 

Pour ajouter une réponse : sélectionner au moins un signalement sur la carte, puis cliquer sur le 
bouton Répondre à un signalement. 

Le formulaire de réponse à un ou plusieurs signalements permet d’inclure un texte et d’attribuer un 
nouveau statut au(x) signalement(s) sélectionné(s) : 

 

Figure 17 : Formulaire de réponse à un signalement 
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Si plusieurs signalements sont sélectionnés, la même réponse et le même statut leur seront affectés. 

5.6 Création d’un nouveau signalement 

Note : avant la création d‘un signalement, il est indispensable d’avoir préalablement chargé une 
première fois les signalements (cf. 5.2). 

 

Sélectionner un ou plusieurs objets sur la carte, puis cliquer sur le bouton Créer un nouveau 
signalement.  

Les objets sélectionnés seront transformés en croquis pour l’Espace collaboratif et joints au nouveau 
signalement si l'option idoine est activée. C’est aussi à partir de ces objets sélectionnés que le plugin 
détermine la position géographique du signalement à créer (situé au centroïde des objets 
sélectionnés). 

Le formulaire suivant permet de : 

• choisir dans quel groupe (parmi les groupes de l’utilisateur) est créé le signalement ; 

• rédiger un commentaire ou utiliser le commentaire par défaut défini par le groupe ; 

• sélectionner le/les thèmes concernés par le signalement ; 

• Remplir les éventuels attributs du ou des thèmes sélectionnés ; 

• joindre un croquis (l’option « joindre un croquis » est cochée par défaut, et détermine s'il 
faut joindre au nouveau signalement le (ou les) croquis généré(s) à partir des objets 
sélectionnés) 

• joindre un document : la taille du fichier ne doit pas excéder 5 Mo, les formats autorisés sont 
listés dans l’annexe 5.3 ; 

• créer un ou plusieurs signalement(s) : dans le premier cas (sélectionné par défaut), un 
signalement unique est créé et positionné sur le centroïde de l’ensemble des objets 
sélectionnés. Dans le second cas, il est créé un nouveau signalement par objet sélectionné, 
avec pour position, à chaque fois, le centroïde de l’objet. 
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Figure 18 : Formulaires de création de nouveaux signalements. 

Un message informe du succès de l'envoi vers l’Espace collaboratif du nouveau signalement, puis 
celui-ci est affiché sur la carte. 

5.7 Nettoyage de la carte 

 

Cliquer sur le bouton Supprimer les signalements de la carte en cours provoque la 
suppression sur la carte en cours de tous les objets IGN_Espace_collaboratif (signalements et 
croquis) qu'elle contenait. 

Les autres données présentes dans la carte ne sont pas affectées par l'opération. 

Les signalements et croquis ne sont pas supprimés sur l’Espace collaboratif. 

5.8 Visualiser les objets associés 

 

Cet outil (baguette magique) permet de sélectionner sur la carte tous les croquis associés à un ou 
plusieurs signalements, ou inversement, tous les signalements associés à un ou plusieurs croquis. 

Exemple : 
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On sélectionne deux signalements (en jaune), puis on clique sur le bouton Voir les objets 
associés. Tous les croquis associés aux deux signalements sont alors sélectionnés 

 

Figure 19 : Exemple d’utilisation de la « Baguette magique » 

Si on clique à nouveau sur le bouton, on retrouve la première situation avec les deux signalements 
sélectionnés. 

 

5.9 Charger les couches de son groupe actif 

 

Cliquer sur le bouton Charger les couches de mon groupe.  

➢ Si l’utilisateur n’appartient à aucun groupe, ou si le gestionnaire de son groupe n’a pas 
paramétré sa carte sur le site web Espace collaboratif, un message indiquant qu’il n’y a pas 
de données à charger apparaît. 

➢ Si l’utilisateur appartient bien à un groupe ayant paramétré sa carte, la fenêtre de 
chargement des couches disponibles apparaît : 
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Figure 20 : Fenêtre de chargement des couches du groupe 

Le formulaire de chargement des couches du groupe est composé de la façon suivante : 

1 Rappel du groupe actif, choisi par l’utilisateur lors de sa connexion au service. 

2 Mon guichet : liste des couches du groupe, hébergées sur l’Espace collaboratif, paramétrées sur 
la carte du groupe. La colonne Rôle indique pour chaque couche si elle est modifiable (rôle 
« Edition ») ou disponible en lecture seule (rôle « Visualisation »). 

3 Fonds Géoportail : liste des couches Géoportail configurées sur la carte du groupe. 

L’utilisateur doit alors cocher les couches qu’il souhaite charger dans son projet QGIS, puis cliquer sur 
Enregistrer : 

➢ Les couches sélectionnées sont ajoutées dans la carte QGIS.  

➢ Dans le gestionnaire de couches, les couches du groupe sont regroupées au sein d’un même 
groupement de couches, portant le nom du groupe actif précédé de [ESPACE CO]. 
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Figure 21 : Aperçu du gestionnaire de couches 

A noter :  

Pour les gros jeux de données comme la BDTopo IGN, il est fortement conseillé, voire 
obligatoire, de sélectionner une zone de travail lors de la connexion au service sans quoi le 
téléchargement ne pourra aboutir. 

➢ l’utilisateur peut charger les couches d’un seul groupe à la fois. Si son projet QGIS contient 
déjà les couches d’un autre groupe, chargées via le plugin Espace collaboratif, elles seront 
supprimées lors de la connexion à un autre groupe. 

➢ Les couches chargées ne sont visibles qu’aux niveaux de zoom définis pour chacune d’entre 
elles sur l’Espace collaboratif. Ceux-ci peuvent être modifiés par l’administrateur de la base 
en cas de besoin. 

➢ Les fonctionnalités QGIS « Zoomer sur la couche » et « Zoomer sur le groupe » (accessibles 
après un clic droit sur une couche ou un groupe de couches dans le gestionnaire de couches) 
ne fonctionnent pas correctement avec les couches issues de l’Espace collaboratif. On peut 
alors : 

o soit zoomer manuellement sur les données pour les visualiser, 
o soit ouvrir la table attributaire de la couche souhaitée, sélectionner un objet et 

cliquer sur « Zoomer la carte sur les entités sélectionnées ». 

➢ En cas d’erreur indiquant que « Le téléchargement des entités a échoué. L’opération est 
annulée », il peut être nécessaire d’augmenter le paramètre QGIS « Délai d’abandon pour les 
requêtes réseaux ». Ce paramètre est accessible dans le menu Préférences > Option > 
Réseau, et peut être rempli avec une valeur de l’ordre de 60000 ms. 

5.10 Editer les couches du groupe (contribution directe) 

Les couches du groupe, chargées à l’étape précédente, définies avec un rôle « Edition » peuvent être 
modifiées par l’utilisateur avec les outils d’édition de QGIS. Attention : une connexion internet est 
nécessaire pour enregistrer les modifications de ces couches. 

La marche à suivre pour modifier les données d’une couche issu de l’Espace collaboratif est la 
suivante : 

➢ Sélectionner la couche à modifier dans le gestionnaire de couches et entrer en mode Edition 
en cliquant sur le bouton QGIS « Basculer en mode édition » :  

 

 

➢ Une fois le mode Edition activé, de nouveaux outils d’édition sont proposés par QGIS. Ces 
outils diffèrent selon le type géométrique de la couche à modifier (points, lignes ou surfaces). 
L’utilisateur peut alors créer, supprimer, modifier géométriquement et sémantiquement les 
objets de la couche à l’aide de ces outils : 
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➢ Cliquer sur le bouton « Enregistrer les modifications de la couche » pour enregistrer les 
modifications réalisées. Celles-ci sont automatiquement enregistrées dans la base de 
données stockée sur l’Espace collaboratif. 

 

5.11 Mettre à jour les couches Espace collaboratif 

 

Le bouton Mettre à jour les couches Espace collaboratif permet de mettre à jour les 
couches issues de l’Espace collaboratif et chargées dans QGIS, afin de récupérer les évolutions qui 
auraient pu y avoir été apportées en parallèle du travail de l’utilisateur. 

➢ Si les couches appartiennent à une base de données historisées, seules les mises à jour 
postérieures ayant eu lieu après le téléchargement des données dans QGIS sont récupérées. 

➢ Si les couches appartiennent à une base de données non historisée, elles sont entièrement 
re-téléchargées. 

La mise à jour ne se fait que sur la zone de travail sélectionnée par l’utilisateur lors de la connexion 
au service. 

A noter : il est conseillé de mettre à jour régulièrement les données, en particulier si le travail via le 
plugin se fait de manière ponctuelle et est entrecoupé de périodes d’inactivité. 

 

5.12 Configurer le plugin IGN_Espace_collaboratif 

 

Cliquer sur Configurer le plugin dans le menu Aide permet d’ouvrir le formulaire d'édition des 
paramètres de fonctionnement du plugin. Tous ces paramètres sont stockés dans le fichier de 
configuration espaceco.xml. 

Dans ce formulaire peuvent être édités les paramètres suivants : 

• Adresse de connexion au service Espace collaboratif : l’url du service : 
https://espacecollaboratif.ign.fr (il est recommandé de la modifier uniquement en cas 
d’instruction de la part de l’IGN). 

• Proxy : permet à l’utilisateur de rentrer ses paramètres de proxy (s’il en a un) directement 
depuis cette interface. Attention, la définition d’un proxy dans l’interface de QGIS (menu 
Préférences > Options > Réseau) ne suffit pas, il doit être défini via ce paramètre pour être 
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pris en compte lors de la connexion à l’Espace collaboratif. En cas de problème de proxy, il 
peut être nécessaire de définir les variables d’environnement HTTP_PROXY et HTTPS_PROXY 
comme indiqué page 10. 

• Date d’extraction si la case est cochée, seuls les signalements mis à jour depuis cette date 
seront téléchargés.  

• Couches sources et champs : permet de paramétrer les attributs à envoyer avec les croquis 
liés aux signalements. Ce paramétrage sera appliqué si la case « Couches sources et 
champs… » est cochée. Par défaut, tous les champs d’un objet utilisé comme croquis seront 
envoyés. 

   

Figure 22: Le formulaire de configuration du plugin. 

5.13 Accéder au manuel utilisateur 

 

Ouvre la dernière version du manuel utilisateur (au format .pdf). 



IGN Manuel utilisateur du plugin Espace collaboratif pour QGIS  Page 22/25 

5.14  Afficher le fichier journal du plugin 

 

Le plugin IGN_Espace_collaboratif enregistre le déroulé des événements dans un fichier journal. Pour 
le consulter, il suffit de cliquer sur Ouvrir le fichier log du plugin du menu Aide. 

En cas de dysfonctionnent, il peut être utile de consulter ce log pour connaître la description 
complète de l’erreur qui est à l’origine du problème. Dans le cadre de sa démarche d’assistance pour 
les logiciels qu’il distribue, l’IGN pourrait être amené à demander qu’on lui envoie ce log pour 
analyser la cause du dysfonctionnement. 

5.15  Le menu À propos du plugin IGN_Espace_collaboratif 

Permet d’afficher les informations de version du plugin. 
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6. Annexes 

6.1 Tableau 1 : champs du calque Signalement 

Nom Type Contenu 

NoSignalement int L'identifiant unique d’un signalement 

Auteur string Le login du compte Espace collaboratif utilisé par le rédacteur du signalement. 

Commune string Le nom de la commune dans laquelle se trouve le signalement 

Département string Le nom du département dans lequel se trouve le signalement 

Département_id string Le code du département dans lequel se trouve le signalement 

Date_création 
Date & 

heure 
La date et l'heure de saisie du signalement (création dans le service). 

Date_MAJ 
Date & 

heure 

La date et l'heure de la dernière action apportée au signalement. (ajout d'une 

réponse, changement de statut et clôture du signalement.) 

Date_validation 
Date & 

heure 
La date et l'heure de l'action de clôture du signalement (prise en compte ou rejet) 

Thèmes string 
La concaténation du nom des thèmes associés au signalement ainsi que des 

éventuels attributs. 

Statut int Le stade d'avancement dans la chaîne de traitement du signalement 

Message string Le commentaire envoyé lors de la création du signalement 

Réponses string La concaténation des réponses apportées à le signalement 

URL string Lien vers la fiche publique du signalement sur l’espace collaboratif 

Document string 
Lien vers le fichier associé à le signalement et  téléchargeable depuis l’espace 

collaboratif. 
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6.2 Tableau 1 : champs des calques Croquis_EC 

Nom du 

champ : 

Type de 

champ : 
Contenu du champ : 

NoSignalement int Le numéro signalement à laquelle le croquis est associé. 

Nom string Le nom du croquis. 

Attributs_croquis string 
Concaténation des éventuels attributs du croquis sous forme : nom 

attribut ='' valeur attribut ''. 

6.3 Tableau 3 : Valeurs et signification des statuts d’un signalement 

N° du 

statut : 
Libellé : Définition : 

Chaîne de 

traitement : 

0 Reçu dans 

nos services 

Le signalement  vient d’être rédigé. Il n’est pas encore pris 

en charge par son destinataire. 
À traiter 

 

En cours de 

traitement 

Le signalement est pris en charge par son destinataire. Il est 

en cours de traitement. 

En cours 

(à finir) 

 

Demande de 

qualification 

Le destinataire n’est pas qualifié pour répondre au 

signalement, destiné à un autre service. Il demande sa 

requalification (le gestionnaire du groupe ou un 

administrateur de l’espace collaboratif réorientera alors le 

signalement vers la bonne personne).  

Il peut aussi s’agir de signalements postés sans thème lié. 

Ils conservent ce statut tant qu’ils ne sont pas liés à un 

thème. 

 

En attente de 

saisie 

Le destinataire a bien pris en charge le signalement, mais sa 

saisie dans la base de données de l’IGN nécessite un délai 

supplémentaire (passage terrain, enquête, …). 

 

En attente de 

validation 

La réponse au signalement est à valider par un utilisateur 

disposant des droits nécessaires. 

 

Pris en 

compte 

Le signalement a été pris en compte. Son traitement est 

terminé et validé. 
Traité 

(terminé) 

 

Déjà pris en 

compte 

Le signalement était déjà intégré dans la base de données 

interne de l’IGN. Son traitement est terminé et validé. 

 

Rejeté (hors 

spec.) 

Le signalement est rejeté car il ne répond pas aux critères 

de sélection appliqués dans les spécifications de nos 

produits. 

Rejeté 

(terminé) 
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Rejeté (hors 

propos) 
Le signalement est rejeté, il est totalement hors sujet. 

6.4 Formats acceptés pour les documents joints 

jpg, png, gif, bmp, tif, aiff, asf, avi, flv, mid, mng, mka, mkv, mov, mp3, mp4, mpg, ogg, qt, ra, ram, 
rm, svg, swf, wav, wmv, abw, ai, bz2, bin, blend, c, css, csv, deb, doc, djvu, dvi, eps, gz, h, html, kml, 
kmz, pas, pdf, pgn, ppt, ps, psd, rpm, rtf, sdd, sdw, sit, sxc, sxi, sxw, tex, tgz, torrent, ttf, txt, xcf, xls, 
xml, zip, odt, ods, odp, odg, odc, odf, odb, odi, odm, ott, ots, otp, otg, gpx, gxt, dxf, crq, docx, xlsx. 

6.5 Fichiers nécessaires au fonctionnement du plugin  

 

  

 

 

 

6.6 Exemple de contenu du fichier de configuration espaceco.xml  

<Paramètres_connexion_à_Ripart> 

  <Serveur> 

    <URLHost>https://espacecollaboratif.ign.fr</URLHost> 

    <Login>mon_login</Login> 

    <Proxy /> 

    <cle_geoportail>Démonstration</cle_geoportail> 

    <groupe_actif>Test ecriture</groupe_actif> 

    <groupe_prefere>Test ecriture</groupe_prefere> 

  </Serveur> 

  <Map> 

    <Date_extraction>01/06/2015 00:00:00</Date_extraction> 

    <Pagination>100</Pagination> 

    <Zone_extraction>emprise</Zone_extraction> 

    <Thèmes_préférés> 

      <Thème>Administratif</Thème> 

Base de données spatiaLite, contenant 
les objets IGN_Espace_collaboratif 

Manuel 
utilisateurs 

Fichiers  de symbologie par défaut pour les objets 
IGn_Espace_collaboratif. 

Fichier de configuration du 
plugin 
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    </Thèmes_préférés> 

    <Afficher_Croquis>Oui</Afficher_Croquis> 

    <Import_pour_groupe>true</Import_pour_groupe> 

    <Atttributs_croquis> 

        <Calque_Nom>lines</Calque_Nom> 

        <Calque_Champ>name</Calque_Champ> 

        <Calque_Champ>desc</Calque_Champ> 

        <Calque_Champ>date</Calque_Champ> 

    </Atttributs_croquis> 

  </Map>  

</Paramètres_connexion_à_Ripart> 
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